
 
 
 

Word 2004 for Mac: Forms 
Learning Guide 
 
 
 Why Use Word Forms? 

If you have ever worked on a project that involves collecting data 
from a group of people, you have probably designed a form using 
Word.  Although a Word form is easier to distribute and use than a 
paper form, users often print the form and send it back with 
handwritten information that may not be easy for you to read.  
Users may also change the layout of your form to accommodate 
the information that they enter.   
 
Word 2003 helps eliminate these problems by allowing you to add 
form elements – text boxes, checkboxes, and drop-down menus – 
to forms you have already designed so they can easily be used 
without the need for any format changes.  Once you have inserted 
these elements, users can enter their data (without disturbing the 
form’s layout), save the form, and return it to you in hard copy or 
via email.  The result is a form that is easy for everyone to use and 
highly readable for you. 
 
 
 
Getting Started 
After you have designed your form in Word, you can insert form 
elements that will allow users to enter their information. 
 
Displaying the Forms Toolbar 
• From the View menu, select the Toolbars submenu. 
• From the Toolbars submenu, select Forms.  
• The Forms toolbar will appear as a floating window near the 

top of your document. 
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Adding Form Elements to your Document 
Once the Forms toolbar is visible, you can add form elements to 
your document.  Word allows you to insert three kinds of form 
fields: 
 
The form fields …  Allow users … 
Text boxes To enter any kind of text, including 

contact and descriptive information. 
Check boxes To answer a question by selecting one 

or more options from a set of responses. 
Also, to supply a yes or no answer to a 
question on your form. 

Drop-down menus To answer a question by selecting one 
option from a set of responses.  

 
 
 
Adding a Text Field to your Document 
Creating a Text Field 
• Click to place your cursor at the location in your document 

where you would like to insert your text field. 
• On the Forms toolbar, click on the Text Form Field button. 
 

 
 

• Word will insert a text box to the left of your insertion point. 
 

 
 

 
 
Tips: Adding Shading to Your Text Field 
• If your form currently provides underlined areas for users to 

enter their responses, be sure to remove all of the underlining 
from each area before inserting your form fields. 

• You can format the contents of a text field just like you can 
format any other text in a Word document: 

o Drag your cursor across a field to select it. 
o Hold down the Ctrl key and click on the field. 
o From the drop-down menu that appears, select the 

Font, Paragraph, or Bullets and Numbering menu 
item to begin formatting the form field. 

o Any formatting you select will be applied to text entered 
by your users in that field. 

Text field 
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• To easily identify your text field within your form, shade it gray 
by clicking on the Form Field Shading button. 

 

 
 
 
Customizing a Text Field 
Once you have inserted a text form field, you can specify several 
options for the field. 
• Double-click on the text field you inserted. 
• The Text Form Field Options window will appear.  
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• To specify the type of text users will enter in this field: 
o Click on the down-facing arrow located next to the box 

labeled Type. 
o From the drop-down menu that appears, select the type 

of text that is appropriate for the response to your 
question. 

 

 
 

For your users to insert…. Select…. 
Names; job titles; other text Regular text 
Numbers; currency values Number 
Dates Date 

 
To automatically insert…. Select…. 
The date the form is completed Current date 
The time the form is completed Current time 
A calculated value Calculation 

 
• To specify a default value for your text field: 

o In the box labeled Default text, type the default value 
you wish to use.  

• To specify the maximum number of characters that can be 
entered in your text field: 

o In the box labeled Maximum Length, type the 
maximum value.  

• To specify the format for the contents of your text field: 
o Click on the down-facing arrow located next to the box 

labeled Text format.  If you have chosen the Number 
or Date format, this box may be labeled as Number 
Format or Date Format. 

• Click on the button labeled OK to apply the options you 
selected to your text field. 
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Tip: When you first create your text field, its Maximum Length is 
Unlimited.  However, when form users enter a great deal of text, 
Word may restructure the layout of your form to accommodate the 
text they enter.  To prevent your form layout from changing, limit 
the number of characters that can be entered in your text field. 
 
 
 
Adding a Check Box to Your Document 
Creating a Check Box 
• Click to place the insertion point at the location in your 

document where you wish to insert your check box. 
• On the Forms toolbar, click on the Check Box Form Field 

button. 
 

 
 
• Word will insert a check box to the left of your insertion point. 
 
 
Customizing a Check Box 
• Double-click on the check box you inserted. 
• The Check Box Form Field Options window will appear.  
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Specifying the Size of Your Box 
When you create your checkbox, Word will an automatically 
assign a size for the box based upon the size of the text in your 
form. To specify the size of your box: 
• On the Check Box Form Field Options window, locate the 

Check box size area.  
• Click on the option button labeled Exactly. 
• In the box next to the Exactly option button, enter the size (in 

points) for your checkbox. 
 

 
 
 
To Place a Check Mark by Default 
In many cases, you may wish to specify that your new checkbox be 
checked by default if the most common answer to its question is 
Yes.  To place a checkmark in the box by default:  
• On the Check Box From Files Options window, locate the 

Default value area. 
• Click on the option button labeled Checked. 
 

 
 

• Click on the button labeled OK to apply the options you 
selected to your check box. 
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Adding a Drop-Down Menu 
Creating a Drop-Down Menu 
• Click to place your cursor at the location in your document 

where you wish to insert your new menu. 
• On the Forms toolbar, click on the Drop-Down Form Field 

button. 
 

 
 

• Word will insert a drop-down menu to the left of your insertion 
point. 

 
 
Adding Items to a Drop-Down Menu 
Once you have created a drop-down menu, you can add items and 
organize them so that they are listed in the order that will be easiest 
to use. 
• Double-click on the drop-down menu you inserted. 
• The Drop-Down Form Field Options window will appear.  
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• In the box labeled Drop-down item, type the first item you 
wish to display in your menu. 

• Click on the button labeled Add. 
• The first menu item will be moved into the box labeled Items 

in drop-down list. 
 

 
 
• In the box labeled Drop-down item, type the second item you 

wish to display in your menu. 
• Click on the button labeled Add to move the second menu item 

into the box labeled Items in drop-down list. 
• Repeat these steps for each additional menu item you wish to 

add. 
 

 
 
 
Reordering Items in a Drop-Down Menu 
Unless you reorder the items in your menu, form users will see the 
items in the order you added them to the menu.  However, Word 
makes it easy to reorder your menu items. 
 
To Display a Menu Item in Higher in the Item List 
• In the box labeled Items in drop-down list, click to select the 

menu item whose position you wish to change. 
• Click on the Move button labeled with the upward-facing 

arrow to move the item one position higher in the menu. 
• Repeat these steps until the item is in its desired location.  
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To Display an Item in a Lower Position on the Item List 
• In the box labeled Items in drop-down list, click to select the 

menu item whose position you wish to change. 
• Click on the Move button labeled with the down-facing arrow 

to move the item one position lower in the menu.  
• Repeat these steps until the item is in its desired location.  
 

 
 
• Click on the button labeled OK to finalize the order of your 

drop-down menu. 
 
Tip: When a user opens up your form document, each drop-down 
menu will display the first item in its drop-down list.  This may be 
confusing for your users. To avoid this problem, add the text 
“Choose one…” as the first item in each menu. 
 
 
 
Making Your Form Easy to Use 
Once you have added form elements to your Word document, you 
will need to add instructions to your form so that its users can 
easily enter information according to your guidelines.   
 
Adding Instructions to Your Form’s Design 
The simplest way to add instructions to your form is to include the 
text of these instructions in the form’s design.  You can draft 
instructions, and include them: 
• At the top of the form, just above the area where your users 

will enter their information.   
• As part of each section of the form 
 
Tip: Be sure to write instructions that are clear.  Also, consider 
providing the users of your form with a step by step process for 
completing the form correctly. 
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Adding Instructions to a Form Element 
In addition to clear instructions in the layout of your form, you can 
also add short instructions to each form element that will pop up in 
a separate window when a form user presses the F1 key after 
clicking on a form element.  To add instructions to a form element: 
• Double-click on the form field you wish to add instructions to. 
• The Form Options window will appear. 
• In the lower left corner of the Options window, click on the 

button labeled Add Help Text. 
 

 
 
• In the Form Field Help Text window that appears, click on 

the tab labeled Help Key. 
• Click on the option button labeled Type your own. 
• In the box beneath the option button labeled, type the text of 

your instructions. 
• Click on the button labeled OK to save the instructions. 
 

 
 

• Click on the button labeled OK t. 
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Testing Your Form 
Once you have added elements to your form, you should test the 
form to make sure that it works the way you intended it to work.   
 
Temporarily Protecting Your Form 
Before testing your form, you will want to temporarily protect it so 
you can us it as your users will.  To protect your form from 
changes except to form elements:  
• From the Forms toolbar, click on the button labeled Protect 

Form.  
  

 
 
 
Entering Your Information 
• Enter information in the form elements you created.  Make sure 

you enter the most common responses in each field, so that you 
can preview the experience that your users will have. 

• To remove all information from your form fields after each 
test: 

o From the Forms toolbar, click on the button labeled 
Reset Form Fields.  

 

 
 
 
Un-Protecting Your Document 
When you have finished testing, you will want to remove the 
temporary protection. To remove temporary protection: 
• Click on the button labeled Protect Form.  
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Protecting Your Form 
Once you have tested your form, you will need to protect the form 
so your users will not be able to change its layout. 
• From the Tools menu, select Protect Document. 
 

 
 
• The Protect Document window will appear.  
• In the Protect Document for area, click on the option button 

labeled Forms. 
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• In the box labeled Password (optional), type the password you 
wish to use to prevent your users from removing the form’s 
protection. 

• Click on the button labeled OK. 
• The Confirm Password window will appear.  
• In the box labeled Reenter password to open, retype the 

password for your form. 
 

  
 
• Click on the button labeled OK. 
 
 
Tips: Setting Passwords 
• Setting a password prevents users of your form from removing 

its protection and changing its design.   
• Select a password that will be easy for you to remember, but 

hard for someone outside your department to guess.  For 
example, do not use the name of your department as the 
password!   

• Set a single password for all of your protected Word forms, or 
one password for each group of related forms.  This practice 
will keep your forms secure but will make it easier for you to 
remember the passwords you set. 
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Removing Protection from Your Form 
If you need to revise your form after you have protected it, you 
will need to first remove the form’s protection before you can 
make any changes. To remove protection from your form: 
• From the Tools menu, select Unprotect Document. 
 

 
 
• The Unprotect Document window will appear. 
• In the box labeled Password, type the password for your form.  
• Click on the button labeled OK to remove protection from your 

form. 
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Tip: Testing Your Form with Actual Users 
Once you distribute your form, there are often logistical factors 
that make it hard to release a revised version of the form.  Before 
you distribute your form, ask some actual users to complete the 
form and provide you with.  Those additional comments will 
probably help you make the form much easier to use. 
 
 
 
Distributing Your Form 
Once you have completed your form and protected it, you are 
ready to distribute your form to the people who will use it.  Here 
are some good ways to make your form widely available: 
• Send an announcement via email to the people who will use the 

new form.  Offer to email the new form to anyone who 
requests it. 

• Save the form as a Word template on your department’s 
network drive (or Q drive) so you or your colleagues can open 
it, make a copy, and fill out the form.  Be sure to tell people 
where they should save completed versions of the form. 

• Post the form on your website so that users can download it.  
On the download page, be sure to specify the email address to 
which users can send the completed form. 
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